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Introduction

The aP23KWC24D USB Writer is designed to suppotu8@P89K series Voice chips. It is suitable for:

- aP89682K( 682 sec, 11 I/0O chip) — DIP24
- aP89341K( 341 sec, 11 I/O chip) — DIP24
- aP89170K (170 sec, 11 I/O chip) — DIP24
- aP89085K ( 085 sec, 11 1/O chip) — DIP24

This development system serves three main functions

Compiler —to create a dp2 file from user’s Voice files
Writer — to program the dp2 file into the aP23xx chip
Copier —connect DC 5V adaptor for 1 to 1 programming

The Compiler is used to combine the edited voice files intodhip to form the desired Voice Group and
to define the playback functions of each Voice Grby selecting different Options and Trigger Modes
of each individual Voice Group.

TheWriter is used to program the voice data into the aP28ex#ces that resulted from the Compiler
Function. A Writer Board connected to the PC viB port is required.

TheCopier is using the compiled *.dp2 which loads to writeen disconnect the USB and connect the
DC 5V for 1 pcs copying.
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Installation

Hardware Installation

aP23KWC24D is a USB based writer programmer. ititsnded to be used in Windows XP,Win7,Win8,
Win10 computer.

Writer Board Connection

1) Connect USB cable from the writer board to the cot@p The computer will display a new
hardware is found message. The installation veifjib automatically.

2) If there are too many USB devices are connectgouo computer at the same time, the current
supply from USB may not be sufficient to suppo# Writer board.

R IS R I I

'] Il‘r v

e~

Fig. 1 The aP23KWC24D USB Writer Programmr Board
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Running The Software
Double click the file23KWComplier.exeto launch the software.

= COMPILER:
e 23K Compiler-v2.3 o *
Compﬂer Writer  About 3 Check Sum: 15. |_|
D OAC Debounce Voltage Qutput Option:
‘ aP89341K 1_I % ” Key Mode 2_| it ‘ Config PYWM (®) 16ms (O 55us ®3av Cutl :Busy-H
(4.5v
Wave File [ High Volume v] Out2 :LED- Flash
4. Set Oscillator: []XT []B¢ [t
Grou edge Holdable Tri Sto Output
o
I L

Type : Compression |——_’—|

OuLaws 3 @ PCM15 Add-Wav

(CIPCME (7) ADPCM4 7. isnence

File Name Size Rate Type Use %

_| VoiceFile Prog - Bus Table Use Table Start T
a.
'IO.I
'13-I' '14.[’ :12.[" :11.I
Usage : 528 < 1048576 (0% ) LoadDp2 Compiler

COMPILER DESCRIPTION:

1. Select your required IC body.
--- aP23682-8pin , aP23341-8pin , aP23170-8pir23685-8pin.
--- aP23682-16pin , aP23341-16pin , aP23170-16aR23085-16pin.
--- aP89682K , aP89341K , aP89170K , aP89085K.

2. Select your required trigger mode.
--- Key mode / CPU parallel mode / MP3 mode / SBd&/ 12C mode / aP89 mode / SBT mode.

3. Select voice output mode.
--- DAC or PWM.

4. Show all your required voice files. (Only wale$ acceptable).
--- The [xxx.wav]: 8 bits or 16 bits mono xxx.wav.

Page 4 of 32 5/6/2016



lf'LUE Integrated Circuits Inc. aP23KWC24D USB Writer User Guide

5. Select the compression mode.
--- ADPCM4 / ULAWS8 / PCM8 / PCML16.

6. Select your required voice file [xxx.wav] folder

7. Select if adding the silence.
--- Ims ~ 10000ms.

8. Loading the required *.wav files.

9. Setting your required voice sections and fumctrede.

10. Show your final voice list.

11. Compiler: After setting the voices & functigpysh the button to create xxx.txt & xxx.dp2 files.
12. Re-download & Re-editing [xxx.dp2] to settimydafunction.

13. Show the memory of your usage.

14. Show the IC body memory size.

15. Show Check Sum.
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e 230 Compiler-V2.3 - >
Compiler  yriter About 5 |Check Sum : |
. 16.[ —
o ! D DAC Debounice Voltage Output Option: g,
P804k v[KeyMode  Jcomfigl 0N @ Oone @ 21, outt ey
(a.5v
Wave File |High'\||'olum( 20. ' Out2 :LED- Flash
Set LVD: [ Off [JO ﬂ
o ” o, o s
Set Oscillator: []XT [Ext Int__"
Grow| edge Holdahle Tri Sto Output
Type : Compression
CIuLAWS ® PCM16 Add-Wav
pcma () ADPCM4 Silence
File Name Size Rate Type |Jse %
VoiceFile Prog - Bus Table Use Table Start T
Usage : 528 < 1048576 (0%) | loadDp2 | Compiler |
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e 23KWCampiler-V2.5 - *
Compiler | writer | About |Chec|( sum : |
(aP23341 - 8pin | [ETTINN ~ | config E1SBT Key3 23 e || EoE

T — (1 PowerOnPlay w 4.5v
SBT Loop| 25. |
Set Volume M Int
Tri Sto Qutput
Type : Compression e

#w 23K Compiler-V2.5 e *

Compiler  writer ~ About |Check Sum : |
apeo341k | [EENITNN - |confi & s
Wavwe File PowerOnPlay = Out2 :LED- Flash

Out3 :Stop-H Stop-H -
[ 5et Volume Int
@SBT:PIPQ Tri Sto Output
OSBT:P/S

e 23KWCampiler-V2.5 - x
Compiler  writer  About |Check Sum : |

aPg9341K ~[[sP1 Mode - | config il | Rt
Wave File PowerOnPiay NV out2 sLED- Flash

Out3 :Stop-H
L1 Set Volume Int
Tri Sto Output
1 CPU Serial Option il
16. Select required debounce time.

--- 65uUs or 16ms.
17. Select if using low voltage detect.
--- Select ON if the IC voltage less than\@M be reset.
18. Select if using the oscillator.
--- XT (X'tal=16MHz ) / Rosc ext ( 68K ohm/ Rosc Int.
19. Select the output function for outputl, outpatiput3.
--- Busy-H, Busy-L.
--- LED Flash (LED high active ) , ~LED FladED low active ).
--- Stop-H, Stop-L.
--- Prog-BusyH, Prog-BusyL.

--- Load: For the play command [094h+D9~00J9~D0] total 10 bits indicate the voice address.

Same the aP89341 preféitth [no gap loop play].
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20. Select PWM voice output volume.

21.

22.

23.

24.

25.

26.

27.

28.

---Select PWM high volume.

Select IC operating voltage at PWM (VOUT).

--- Low Voltage: 3V, High Voltage: 4.5V.

IC body configures advanced function.

Select SBT pin swap. (for 8pin device only).
--- Select (SBT as OUT1) or (SBT as KEY3).

--- SBT as OUTL1: Busy-H/L, Stop-H/L, LED FHed_ED high active),
~LED Flash (LED low active), Prog-BusyH/L, Load.

S3 (pin7) S2 (pin6) Group SBT = OUT1
0 1 SW1 Busy-H/L
1 0 SW2 Stop-H/L
1 1 SW3 LED ......

--- SBT as Keya3:

SBT ( pin5) S3 (pin7) S2 (pin6) Group
0 0 1 SW1i
0 1 0 SW2
0 1 1 SW3
1 0 0 SW4
1 0 1 SW5
1 1 0 SW6
1 1 1 SW7

Select power on play.

--- Power on play [sw0] group once.

Select SBT loop. (At SBT mode).
--- Enable: The SBT pin sequential triggelo&p play.
--- Disable: The SBT pin sequential triggepl&ay once.
*Note: Voice function (Trig Level) must select Ledy

Select volume control function.

--- Select the volume control Level x16 //x81.

SBT pin act play/pause or play/stop functionM®3 mode.

Select if using pin S4 as data output pin.
--- The SPI mode or 12C mode of data output fopR4IC body and 16 pin IC body.
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= WRITER:
#w 23N Compiler-V2.5 . *
Compiler  Writer  About Check Sum :
Grou| edge Holdable Tri Stol Output
2|
«
VoiceFile Prog - Bus Table Use Table Start T
5|

N 2 N 2 0 R
Blank Check Program Verify O ‘E,ec_ulrit'n,r J |_aP23682 -8Pin -~
1. Run 12.§ u

0 D}fﬂ Load to Flash Load

WRITER DESCRIPTION:

1. Loading your programming file. (xxx.dp2)

2. Show setting and function after loading *.dg2.fi
3. Show your required IC body.

4. Show voice sections and function mode.

5. Show the content of your selected section afevtist.

(o2]

. Select to blank check IC is blank?
7. Select to execute programming.
8. Select to verify the data of your programming.

9. Select if you need security mechanism.
*** (If do this, it can’t be copied; it can’t be Mzer IC.)
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10. Execute your selected (6.) (7.) (8.) (9.).

11. Show the progress of “blank check”, “prografwérify” and “load to flash”.
12. Load to Flash: download the program file (xp2pto [1 to 1 copier] writer.
= About:

ine 23KWCompiler-V2.5 . *

Compiler  Writer About Check Sum :

1.
-'a P23xxx Series Voice OTP Development System

Version 2.5

Aplus Integrated Circuits Inc.

2. :
—waw.aplusmc.com.tw

sales@aplusinc.com.tw

3.
-' Writer Firmware Version Detect

4.
—Jﬁrmware Update

ABOUT DESCRIPTION:

1. Show software version.

2. Show website of Aplus Integrated Circuits Inc.
3. Detect writer firmware version.

4. Update writer firmware version.
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= Example for Compiler :

e 23KV Compiler-V2.5 —
Compiler  \Writer  Abeadt ) c Check Sum :
— d b_l D DAC Debounce Voltage Output Option:
aP23682 - 8Pin —| Key Mode | config Glpam @ 16ms Osss @0 d |
4.5V
Wave File | High Volume e_‘l O
boku, wav Set LVD: off [Jon
R Ermers Set Oscillator: [ |XT [ |Bxdt /]It
MUSIC 02.wav
Super16A. wav M Group edge Holdable Trig Stoy Qutput
Train 01.wav P
| HELTHE x|
f Please Select a Folder
Type : Compression j
CuLaws ®PCM1s Add-Wav |
IPCMB () ADPCM4 Silence v o Data (D) "
b4 A
File Name Size Rate Type Use %
wav
- wave E
ABT Builder =
| it B
Auto'Writer-APP
Builder_Project
China_Customer
Chk_dll
Cus wav ”
d
BE Eia
Usage : 528 < 2007152 (0%) | Loadbpz | | Compiler

1. Select the IC body is [aP23682 - 8Pin].

2. Select [Key Mode] to be our trigger mode.
3. Select the voice output is [PWM].

4. IC operating voltage at 3V.

5. Select PWM high volume.

6. Click Add-Wav to pick your required folder.
7. After confirming the folder, click the button.

8. All wav files in the folder will be listed here.
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e 23K Compiler-W2.5 = >
Compiler  writer  About |Check Sum : |
_ : D DAC Debounce Voltage QOutput Option:
aP23682 - 8Pin | Key Mode ~|config) =€ | @ lems Ossus | @3
4,59
Wave File | High Volume v | ©
baku.wav Set LvD: [Z]off [Jon
CHILD. wav u Set Oscillator: | |%T [ |Bxt |Int
MUSIC 02, wav

Super 164, wav Group edge Holdahle Trig Stop Output

Train 01.wav

Type : Compression

OuLaws U (OPcMis Add-Wav
@ pCMs () aDPCM4 k [Silence

5 B . 1 Use %%
) Silence Time (1 ~ 10000 mS) Ok
2

4
;ll mS Cancel : VoiceFile Prog - Busy Table Use Table Start | Type

Super 164, wav 512296 16000 PCM3 12
Train 01.wav 46618 12000 PCMB 2
Silence @ 20mS 0 16000  Silence 0

i

i-1 |
Usage : 503624 < 2097152 (24% ) | LoadDp2 Compiler

9. Show all your required *.wav files. Double cliakav files you required in h, they will be showed.i
9-1.1f you once required multiple wav files to beowsed in i. (Mouse left button as begin item after

mouse right button as end item and click Add-MWhav at the same time).
9-2.1t will show the memory size you has been used.

(Please note the data size you loaded can’t exbedoody’s memory).

*** Please note the data size you loaded can't eddbe body's memory. If so,

there are some ways to solve this problem:

1). Change it to a bigger memory size bodya®23085-8Pin to aP23341-8Pin.

2). Compressed the wav files to decreasenéraory size. ex: from PCM16 to PCM8.

3). Delete some required voice files.

10. If wav file is too big, we can choose compnegdiles to decrease their sizes.
(UALW8 compress wawv file to 8bits, PCM8 congmeavav file to 8bits,
ADPCM compress wav file to 4bits).
*** Please note if your original voice is 16bits wéle which need to be compressed to 8 bits,
We suggest you choose ULAW would be better.
11. If you want to add mute voice, click Silencetbn to set the silence time.

12. If need silence 20ms. Key in 20 (unit ms) thikck OK button.
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#ne 23K Compiler-W2.5 — e
Compiler  ywriter About |Check Sum : |
Debounce m Voltage 1y | Output Option:
aP23682 - 8Pn - | Key Mode v ‘Lpac ul J
‘ Y Config = C o @16ms Ossus @3
] ol Oasv
Wave File | High Volume
boku, wav Set LvD: A off [Jon P ﬂ
. Set Oscillator: [ T [ TBxt /]It
MUSIC 02.wav
Super16A. wav | Grou edge Holdable Tri Sto Output
Train 01.wav !
!
|
i
Type : Compression e |
OuLaws (CIPcMis [ Add-Wav | !
(® PCMa (") ADPCM4 I Silence ‘ |
: |
File Name Size Rate Type Use % !
boku, wav 35650 12000 PCM3 2 | 1
CHILD.wav 91676 12000  PCMa 4 | VoiceFile Prog - Bus Table Use Table Start T [
MUSIC 02, wav 73004 12000 PCM3 3 |
Super 16A.wav 512295 16000 PCMB 12 i |
Train 01.wav 46618 12000 PCM3 2 |
Silence : 20mSs 0 16000 Silence 0 |
i
i
|
i
|
|
l
Usage : 503624 < 2007152 (24% ) | LoadDp2 | . Compiler |
i 23K Compiler-V2.5 . >
Compiler  yyriter  About |ChECK Sum: |
X I ] r tage Qutput Option:
aP23682 - 8Pin v|| Key Mode - config (4SBT Out1 JJ £ i o
s
4.5V
T ] PowerOnPlay ﬂ
AR SBT Loop t |
CHILD.wav Set Volume ﬂ Int
MUSIC 02.wav
SEnaT A Tri Sto output |
Train 01 waw |
: | Close
Type : Compression = o .
= . AAA_ VAT | I
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i 23K Compiler-V2.5 = x
Compiler  yyriter  About |Check Sum : |
[aPso170k  .|[SPI Mode | config rocal N B

Wave File PowerOnPlay V. outz iLED- Flash
boku.wav ﬂ Volume Warp ¢ [ |Disable []Enable lm
;:I;-[DCII;I:,\:\-BV Set Volume Vol Level : ol Default : IS—VI

Train 0Lwav w Sk

CPU Serial Option [ SPI - 4 wire : Pin 54 as DO

Close I2C - 3 wire : Pin 54 as DO

Type : Compression
O uLaws O)PCMIG Add-Wav PULL-TYPE

(® Internal PULL-UP

(® PCMa () ADPCMA4 Silence
(Mo internal PULL-UP
File MName Size Rate Type Use %
i Set w-1 |
boku,wav 35650 12000 PCM3 F

13. Select the signal timing. (16ms or 65us).

14. IC operating voltage at 3V.

15. Select PWM high volume.

16. Select set Low Voltage Detect when voltage tleas 2V IC will be reset.

17. Select set Oscillator from Crystal mode(X'téd#dHz), External Rosc mode(68K),
Internal Rosc mode. ( if selecting Crystald®olt must set at pin MO & pin M1).

18. SBT pin swap other I/O pin function.
ex : SBT pin swap to OUT1 as output use.

19. Disable the power on play function. It doesinonhediately play [SWO] once.

20. When trigger in “SBT mode”.
If enable the [SBT Loop]: It will one key sequehtidgger and keep loop play in every group.
If disable the [SBT Loop]: It will one key sequaltirigger and play one time in every group.
(*** Note: Trig Level must select Level).

21. Output Option: Setup the outl, out2, out3.
Can select the Busy-H, Busy-L, Stop-H, Stop-L
LED Flash (LED high active), ~LED Flash(LED lowtee),
Prog- BusyH, Prog-BusyL, Load.

22. [Set volume] control function.
---Select the volume control Level x16 / x8 / x4.
---The volume control key by the [M1] and [MO] key.
Volume Warp: Volume level increase to the max thegin from the level 1.
Select disable:
Pin MO: volume Level [+ 1].
ex: Level x8, 2>32>4->52>6>7>8>8->8-> ....
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Pin M1: volume Level [- 1].

ex: Level x8, 7>6>52>4>3>22>1>1>1-> ...
Select enable:
Pin MO: volume Level [+ 1].

ex: Level x8, 2>324>5262>72>82>12>2>32> 4~>....
Pin M1: volume Level [- 1].

ex: Level x8, ®72>6>524>32>22>12>82>72>6>5> ....

aP23KWC24D USB Writer User Guide

23. When set SPI Mode or I12C Mode, the pin S4iigiéda output (DO) using.

#e 230N Compiler-V2.5

Compiler  yriter  About |ChECk sum:
; Debounce Vaoltage Qutput Option:
aP23682 - 8Pn | Key Mode | [Jpac
ki Y ~ | Config FUWM @ 16ms D 65us g v Outl :Busy-H
4.5V
Wave File | High Volume i |
boku.wav Set LvD: Foff [Jon
CHILD.wav Sat Oscillator: [ |XT [ |Bxt /] Int
MUSIC 02.wav
Super 164.wav Holdable
e L Unholdable Retrigger
Unholdable _|Retrigger __[Enable
SW3 Trig Level Haold Trigger Stop

S — (OiLevel (® Unholdable () Mon-Retrigger () Disable
OuLaws CIPcM1s Add-Wav (®) Edge () Holdable (®) Retrigger (®) Enable
(® PCMB ) ADPCM4 Silence y

SW?2 ILJ oK Cancel
File Name Size Rate Type se %
boku.wav 35650 12000 PCM2 2
CHILD. wav 91675 12000 PCM3 4 VoiceFile
MUSIC 02.wav 73004 17000 PCMB 3 TR
Super 16A.wav 512296 16000 PCMS 12 HILD. way
Train 01.wav 466158 12000 PCM3 2

4

Usage : 503736 < 2097152 (24 %) LoadDp2 Compiler

24. Double click Panel-A for your setting the fuonatof each Group.
25. Key in group number.

26. SW means group. ex : Select the second gradipl@uble click the wav files you required in (i)
then Panel-B will show them.
The mouse moves to Panel-B then enter right keydar adjusting the order of the wav files or irtser
or delete them.
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| 23KWCompiler-v2.5 - x
Compiler \riter About |Check Sum: |
G B D DAC Debounce Voltage Quiput Option:
|aP23682 - 8Pn | Key Mode | config oo @tms Ofss | @ | Outtiusy-H
- () 4.5v
Wave File | High Volume s |
boku.way Set LVD: [ Off []On
i o Set Oscillator: | |XT [ |Ext /]It
MUSIC 02.wav
Super16A.wav Group | edge | Holdable | Trig | Stop | Output
e L= SWi Edge Unholdable Retrigger Enable
Sw2 |Edge |Unhaoldable  |Retrigger |Eaakls
SW3 Edge Unholdable Datrigger Add
_ z-1 | Multi-Add
Type : Compression SW-Begin: |2 0ok =
d t
OIULAWS O PCM16 Add-Wav SR ﬂ
SW-End: Cancel Play
® PCMa () ADPCM4 Silence
Trig Level Stop
File Mame Size Rate Type Use %% OLevel ® Edge .
Hold
boku.wav 35650 12000 PCM3 2
(® Unholdable () Holdable
CHILD. wav 91676 12000 PCM3 4 VaiceFile : le Start | Type
MUSIC 02.wav 73004 12000 PCM8 3 Trigger—— _
Super 164.wav 512206 16000 PCM3 12 CHILD.wav O Nan-Retrigger @ Retrigger PCMS
Train 01.wav 45518 12000 PCME 2 MUSIC 02, way Stop

PCM3
() Disable (®) Enable

B A

Usage : 503736 < 2097152 (24 %) LoadDp2 Compiler

27. If the mouse move to Panel-A and enter riglyt kewill show there are additional function faildy
multi-add, delete, play and stop.

Add: add single group.
Multi-Add: add multi-groups at one time (z-1).
Delete: delete the group.
Play: play all voices of the group.
Stop: stop the voice playback.
28. Finish compiling, click compiler button.
29. Generate Check Sum number.

30. Loading finished compiled .dp2 file.
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e 23K Compiler-V2.5 o b4
Compiler  writer About |Check sum : |
. ) I | [Jpac Debounce Voltage Output Option:
|aP23682 - 8Pn || Key Mode v|lconfia| 52 @ ms Osse @ outt sy
D45y
Wave File | High Volume [ |

Set LVvD: A oOff [Jon
Set Oscillator: | XT Ext Int

_l Groui ’ edie l Hoid.aEIe l Trii l Stai ’ Duqit l

File is not exist =
cl |
Type : Compression : - DAvwavehbokuwawy |
O uLAWS @ PCM16 Add-Wav || 1 I D\A\weve\CHILD wav 3
IpCME () ADPCM4 Silence || E
File Mame Size Rate Type |Jse % \‘ E
boku.wav [u} 0 PCMB ] -
CHILD. wav 0 0 pCMa 0 VoiceFile Frog - Bus Table Use Table Start T
MUSIC 02.wav 73004 12000 PCM3 3
Super 164 wav 5122965 16000 PCME 12
Train 0 1.wav 46618 12000 PCM3 2
Panel-C I Play
Stop C1
Remove
Remowe All
Madify Path
sage : 376298 < 2097152 18 % LoadDp2 Compiler
L (18%) p

31. Reloading .dp2 file if the voice file (*.wa\g not exist.

32. The mouse moves to Panel-C then enter rightdteyour modifying the path of the wav files.
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= How to write the program file [ xxx.dp2 ] to IC :

e 23KWCompiler-W2.5

Compiler  Writer  About

— x
Check Sum : C1B1

Enable
Enable

Unholdable
Unholdable

Retrigger
Retrigger

CHILD.wav 1 0 0
MUSIC 02.wav 1 0 0

d]

D:\A\demo'\demol.dp2
Key Mode

Use: PWM , Low Voltage : 3V
VOUT [ PWM ] - Level 6
Power On Play: Disable
Use: Rosc Int

LvD: Off

SBT as Outl

OutPutl: Busy- H
Execute Blank Check...
Blank Ckeck Success
Execute Program...
Program Finish

Execute Verify...

Verify Success

b

Blank Check Verify [ Security

Program

bt |

| aP23682 - 8Pin

o 5]

Load to Flash Load

a. Click [Load] button to load the program file g&p2] file.

After loading, it will show Check Sum b~ c~d message.

e. Select Blank Check to check if this IC is blank.
Select Program to execute programming.
Select Verify to execute verification.
Select Security to execute IC security mechanism.

***(To avoid the data to be copied and it can’tdenaster IC).

f. Click Run button to execute all your selecteiris in e column.

(Il show (e.) progress & (b) message).
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g. Click [Load to Flash] button to download .dp2 fio Writer.
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When writer is able to be a 1 to 1 copier. ***Y must do g. step at first)
1. Disconnect USB.

2. Connect 5V adapter.

3. Push program key to execute programming.

4. When programming, yellow LED flash.

When programming finished, green LED light.
When programming failed , no LED light.
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= Example for About :

s 23K Compiler-v2.5 = x

Compiler  Writer About Check Sum : C1B1

aP23xxx Series Voice OTP Development System

\ersion 2.5

Aplus Integrated Circuits Inc.

J www.aplusinc.com.tw

sales@aplusinc.com.tw

J Writer Firmware Versiom : V114

J Firmware Update

a. Double click thevww.aplusinc.com.twvill connect website Aplus Integrate Circuits Inc.

b. Double click the Writer Firmware Version will®l writer firmware version.

c. Double click the Firmware Update will load firrave file.
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***Note:

Writer and Copier only support the (*.dp2) fileom 23KWCompiler version V2.4 or up.

Q1: How to update the latest firmware version.
Q2: How to convert (*.dat) format to (*.dp2) format

Q3: How to convert V2.1 & V2.2 & V2.3 (*.dp2) to V2 or up (*.dp2) format.

Ansl.:
de 23K Compiler-V2 5 — b
Compiler Writer  About Check Sum :
Grou edge Holdable Tri Stoj Output C:\Users\RD\Desktop\test_file\w2_3-dac.dp2
Writer Disconnect
Writer Information x
VoiceFile ’ Proi - Busi ’ Table_ @ Writer disconnect
I [
Blank Check Program Verify [ Security ‘ aP23682 - 8Pin v|
Run
U Dfﬂ Load to Flash Load

a. Writer must be connected PC after load (*.dp2) file
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b. If Writer doesn’t connect PC, it will show Writeisdonnect message.

dne 23K Compiler-W2.5 — >
Compiler Writer  About |Check Sum : |
Grou edge Holdable Tri Sto Output C:\Users\RD\Desktop'test_file\w2_3-dac.dp2
1
Firmware Update >
VoiceFile Prog - Bus ]

0 Update the latest version firmware

Blank Check Program M Verify [ Security |aP23682 - 8Pin v|

Run

0 D.-‘fCI Load to Flash Load

c. If Writer connects PC,it will show Update the ldtesrsion firmware message.

d. Please click OK button.
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e 23K Compiler-W2.5

Compiler Writer  About

Grou| edge
VoiceFile
Blank Check

Haoldable

Prog - Bus

Program

= it
Tri Sto Output Get Imqg file (AP243C{_USB_Writer_v114.imq)
Execute Update Firmware...
Update Firmware Finish

Please replug in Usb Writer

|
- Firmware Update =
—|  Update Firmware Finish _..!
Table Use Please replug in Usk Writer
T T |
Verify [ Security |aP23682 - 8Pin |
Run
0 9% Load to Flash Load

e. After finishing firmware update, click OK button@neplug in Usb Writer.
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s 23K Compiler-V2.5 . *

Compiler  Writer About |Check Sum : 3036 |

aP23xxx Series Voice OTP Development System

Version 2.5

Aplus Integrated Circuits Inc.

www.aplusinc.com.tw

sales@aplusinc.com.tw

Writer Firmware Versiom : V114

Firmware Update

f. You can see About page to check Writer Firmwaresioer.
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Ans2:

dne 23KWCompiler-V2.5 - bt

Compiler  Writer  About Check Sum :

Groui ’ edie ’ Holdable ’Trii ’ Stoi ’ Ouﬁt
| |

X
e » T » EE » testfile w |0 EE test file o
HEZE - EERE =~ [H 0
& Downloads # ~ 2% B EE: 5 7
W == o 1% v1_2-dac.dat 2016/4/28 F51.. DATB= 1,024 KB
[ & #* 19 v1_2-pwm.dat 2016/4/28 L5 1. DATBE 1,024 KB
= B8R » 150 v2_3-dac.dp2 2016/4/28 F5 1. DP2 X 1,025 KB
— 150 v2_3-pwm.dp2 2016/4/28 £S5 1.. DP2E= 1,025 KB
pic
test_file
TestGoGo
@ Onelrive
= B
* Downloads
B ==
h 52
W =a
EBRSEN): (vi_2-dacdat v| data files (*.dp2;*.dat) v
BE(O) HiE

a. At Writer page click Load button and select (*.dab.
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dne 23K Compiler-Va.5 e =
Compiler Writer  About |Checl-: Sum : |
Grou edge Holdable Tri Stoy Output C:\Users\RD\Desktop'test_file\wl_2-dac.dat
|
Fdat to *dp2 pd

VoiceFile Prog - Bus | (%dat)file format will be changed to (*.dp2) format

Blank Check Program Verify [ Security \ aP23682 - 8Pin v|

Run

U Df‘ﬂ Load to Flash Load

b. 1t will show (*.dat) file format will be changed {¢.dp2) format message.

c. Click OK button.
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e 23K Compiler-V2.5 - X

Compiler  Writer — About Check Sum :

Group edge Holdable Trig Stop Output C:\Users\RD'\Desktop\test_file\vl_2-dac.dat

e BEEE X

e » T » EE » testfile v @ EE test_file o

4

[ER
®t
Erd

>
ikr

(ST

il i

o

=l ER * i v2_3-dac.dp? 2016/4/28 5 1. DP
demo ol w2_3-pwm.dp2 2016/4/28 F+1.. DP

test_file

TestGoGo

¢@ COneDrive

4 Downloads

[ x#

b ==

W =E

= EE Y

=ELA- A VBT _2-new-dad] v

ZFBEET): | data files (~dp2) v

~ EEERE s

d. Now save (*.dat) file as (*.dp2) file. The (*.dp2an be used as the data for program and verify. only
The (*.dp2) file don’t include sufficient informain for re-load to the compiler.
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Ans3:
e 23K Compiler-W2.5 — oo
Compiler Writer  About |Checl-: Sum:
Grou edge Holdable Tri Sto Qutput C:\Users\RD\Desktop\test_file\v2_3-pwm.dp2

VoiceFile ’ Pr| CheckSum Information x

| . The checksum will be modfied for new version compiler

Blank Check Program [ Verify [ Security | aP23682 - 8Pin v|

Run

U Dfﬂ Load to Flash Load

a. At Writer page click Load button.

b. Because the check sum rule has been modifiedadtsion VV2.4,the check sum maybe different
from the original one.
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Compiler  Writer  About Check Sum :

Group edge Holdable Trig Stop Output

C:\Users\RD\Desktop\test_file\v2_3-pwm.dp2

e DTS X
L y Tt » EE » testfile v O EE test_file yel

EoTE -~ HREEHR =~ @

A

L WER
®

5

>

ik

it

9 v1_2-new-dac.dp2
demo ¥l v2_3-dac.dp2
pic ol v2_3-pwm.dp2

kL

2
=
%]
T ST 1

b
=1
s}
L
7=
o

test_file
TestGoGo

& OneDrive

‘ Downloads

&
=&

W =E

= EE e
=E L TN 3 new chksum] -
ZEREAT): |data files (*dp2) =

~ BEENE e

c. Now save (*.dp2) file as version V2.5 (*.dp2) filehe (*.dp2) include sufficient information
for re-load to the compiler.
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Inserting Devices into the Programmer

-  DIP package devices
- Device should be inserted align to the bottom ef2#-pin textool socket.

For

aP&9085K-DIP24
aP89170K-DIP24
aP89341K-DIP24
JaP80682K-DIP24

LB _ B B B B B R B B B =
-h-—-l—E--

F|-H|='-1-rr|.-'-1. ~ 0
A it o

'l'l
L By

| APZBKWCZ4D % B
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HISTORY

2015/03/27
aP23KWC24D User Guide.

2015/05/20
Dat file become dp?2 file.

2015/07/17
Add>Device map & Check Sum

2015/09/18
Add->Low voltage reset & CPU serial option.
Modify> Trigger mode & Silence time & Usage memory size ¥e€iite Run component control.

2016/02/01
Add-=> Auto detect writer firmware version.
Add-> MP3 mode Play/Pause & Play/Stop option.

2016/02/24
Add-> Q&A.

2016/05/06
Add-> Select IC operating voltage.
Add-> PWM voice output volume.
Modify—> Change LVR to LVD.
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